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About this book

Document description

This installation guide describes how to install and configure the following
products:

+ IBM® WebSphere® Commerce Developer Business Edition

* IBM WebSphere Commerce Developer Professional Edition

* IBM WebSphere Commerce - Express Developer Edition

It is intended for developers or system administrators who are using WebSphere

Commerce Developer to develop store-front assets and back-office business logic to
run with the following products:

* WebSphere Commerce Business Edition
* WebSphere Commerce Professional Edition
¢ WebSphere Commerce - Express

When developing for an edition of WebSphere Commerce, you must use the
matching edition of WebSphere Commerce Developer. For example, when
developing for WebSphere Commerce Professional Edition, you must use
WebSphere Commerce Developer Professional Edition.

Conventions and terminology used in this book
This book uses the following highlighting conventions:
Boldface type Indicates commands or graphical user interface (GUI) controls
such as names of fields, icons, or menu choices.

Monospace type Indicates examples of text you enter exactly as shown, file names,
and directory paths and names.

Italic type Used to emphasize words. Italics also indicate names for which
you must substitute the appropriate values for your system.

host_name The fully qualified host name of the WebSphere Commerce
development environmentsystem (for example,
serverl.torolab.ibm.com is fully qualified).

This icon marks a Tip - additional information that can help you
complete a task.

— Important
These sections highlight especially important information.

 Attention
These sections highlight information intended to protect your data.
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Indicates information specific to WebSphere Commerce Developer Business
Edition

s Indicates information specific to WebSphere Commerce Developer Professional
Edition

eyl [ndicates information specific to WebSphere Commerce - Express Developer
Edition

ey Indicates information specific to IBM Cloudscape ™ database.

Indicates information specific to DB2 Universal Database . All references to DB2
Universal Database in this book refer to the edition of DB2 Universal Database
supported by the edition of WebSphere Commerce Developer you are using.

If you are using WebSphere Commerce Developer Business or Profession edition,
DB2 Universal Database Enterprise Server Edition is supported.

If you are using WebSphere Commerce Developer - Express, DB2 Universal
Database Express Edition and DB2 Universal Database Enterprise Server Edition
are supported.

Indicates information specific to Oracle9i Database.

This book uses the following terms:

back-office business logic
The part of your store that customers do not see. Back-office business logic
includes WebSphere Commerce commands, data beans, enterprise beans

development machine
The machine onto which you install WebSphere Commerce Developer to
develop store-front assets or back-office business logic for WebSphere
Commerce.

store data
The information for a store that supports all customer activities. Store data
includes catalog information, shipping charge information, and inventory
information.

store-front assets
The part of your store with which your customers interact. Store-front
assets include HTML pages, JSP files, style sheets, images, graphics, and
other multimedia file types that define the layout and content of your Web

pages.

Path variables

This guide uses the following variables to represent directory paths:

WCDE_installdir
This is the installation directory for the WebSphere Commerce toolkit. The
default installation directory for the WebSphere Commerce toolkit, depends
on your edition of WebSphere Commerce Developer:

S C:\WCToolkitBE5S7

C:\WCTooTkitPro57
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b Express | C:\WCToolkitExpress57

WSAD_installdir
This is the installation directory for WebSphere Studio Application
Developer.

The default installation directory for WebSphere Studio Application
Developer is C:\Program Files\IBM\WebSphere Studio\Application
Developer\v5.1.2.

Important: The default installation path is too long for configuration with
the WebSphere Commerce toolkit. When installing WebSphere Studio
Application Developer, specify a much shorter direcotry such as
C:\WSAD512.

Knowledge requirements

This book should be read by developers or system administrators who are
installing WebSphere Commerce Developer to develop store-front assets and
back-office business logic to run with WebSphere Commerce.

Developers or system administrators who are installing and configuring
WebSphere Commerce Developer should have knowledge in the following areas:

* Knowledge of one of the following operating systems:
— Microsoft® Windows® 2000 Professional Edition
— Microsoft Windows 2000 Server Edition
— Microsoft Windows 2000 Advanced Server Edition
— Microsoft Windows XP Professional

Ll Business | IBM DB2® Universal Database or Oracle database
- BEZZM 1BM DB2 Universal Database

* Basic SQL commands

This knowledge should include how to complete administration and configuration
tasks for the operating system and database server.

Developers who are developing store-front assets or back-office business logic with
WebSphere Commerce Developer should have knowledge in the following areas:

* IBM WebSphere Commerce
* IBM WebSphere Studio Application Developer

> Business | IBM DB2 Universal Database or Oracle database

- BETEM 1BM DB2 Universal Database

* Java ' programming language

« Enterprise JavaBeans' component architecture
* JavaServer Pages technology

* HTML

+ XML

About this book V
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Part 1. Welcome to WebSphere Commerce Developer

This book describes how to install and configure WebSphere Commerce Developer
(formerly WebSphere Commerce Studio). It is intended for developers or system
administrators who are using the WebSphere Commerce Developer to develop
stores and WebSphere Commerce application code.

LEEN If you are using WebSphere Commerce Developer Business Edition to
create customized Java code, it can only be deployed to a WebSphere Commerce
Business Edition application.

If you are using WebSphere Commerce Developer Professional Edition to
create customized Java code, it can only be deployed to a WebSphere Commerce
Professional Edition application.

- Express IO you are using WebSphere Commerce - Express Developer Edition to
create customized Java code, it can only be deployed to a WebSphere Commerce -
Express application.

For instructions on the installation and configuration of WebSphere Commerce,
refer to WebSphere Commerce Installation Guide for Windows.

WebSphere Commerce Developer should be installed on a separate machine from a
WebSphere Commerce production or staging environment.
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Products included with WebSphere Commerce Developer

The following products and components are packaged with WebSphere Commerce
Developer:

* WebSphere Studio Application Developer, Version 5.1.2
* WebSphere Commerce Version 5.7 toolkit
* WebSphere Commerce, Version 5.7

WebSphere Commerce for Windows is included with WebSphere Commerce
Developer for testing purposes. If you want to put your site into production
using WebSphere Commerce, you must purchase a licensed copy of WebSphere
Commerce.

For a list of products and components provided with WebSphere Commerce,
refer to WebSphere Commerce Installation Guide.

© Copyright IBM Corp. 1996, 2005 3
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Part 2. Planning your WebSphere Commerce Developer
installation

This section contains information on planning your installation of WebSphere
Commerce Developer, including the prerequisites for WebSphere Commerce
Developer.
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Migrating previous versions of WebSphere Commerce
Developer

Migration to WebSphere Commerce Developer, Version 5.7 from the following
versions of WebSphere Commerce Developer is supported:

* WebSphere Commerce Developer Version 5.6
* WebSphere Commerce Studio Version 5.5
* WebSphere Commerce Studio Version 5.4

Migration from other versions of WebSphere Commerce Developer is not
supported.

For information on how to migrate to WebSphere Commerce Developer, Version
5.7 from previous versions of WebSphere Commerce, refer to the WebSphere
Commerce Developer Migration Guide.

The Migration Guides are available from the WebSphere Commerce technical
library:

|http://www.ibm.com/software/commerce/1ibrary/|

© Copyright IBM Corp. 1996, 2005
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Coexistence with previous versions of WebSphere Commerce

Developer

WebSphere Commerce Developer, Version 5.7 can coexist on the same machine
with the following previous versions of WebSphere Commerce Developer:

* WebSphere Commerce Developer Version 5.6
* WebSphere Commerce Studio Version 5.5
* WebSphere Commerce Studio Version 5.4

Coexistence of other versions of WebSphere Commerce Developer is not supported.

Coexistence with other editions of WebSphere Commerce Developer is not
supported. Different versions of the same edition of WebSphere Commerce
Developer can coexist but not different editions. For example, coexistence of
WebSphere Commerce - Express Developer Version 5.6 and WebSphere Commerce
Developer Business Edition Version 5.7 is not supported, while coexistence of
WebSphere Commerce - Express Developer Edition Version 5.6 and WebSphere
Commerce - Express Developer Edition Version 5.7 is supported.

When installing WebSphere Commerce Developer, Version 5.7 in a coexistence
environment, no additional steps are required to prepare for or complete an
installation of WebSphere Commerce. Follow the instructions for installing
WebSphere Commerce Developer, Version 5.7 in this book.

WebSphere Studio Application Developer considerations for

coexistence

© Copyright IBM Corp. 1996, 2005

If you plan to install WebSphere Commerce Developer, Version 5.7 in a coexistence
environment, keep in mind the following information about WebSphere Studio
Application Developer coexistence:

* If you have WebSphere Studio Application Developer, Version 5.0 installed,
WebSphere Studio Application Developer, Version 5.1.2 can coexist with it.

* If you have WebSphere Studio Application Developer, Version 5.1 installed, you
must upgrade WebSphere Studio Application Developer to Version 5.1.2.
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About WebSphere Commerce Developer

WebSphere Commerce Developer is the combination of WebSphere Studio
Application Developer and the WebSphere Commerce toolkit. The WebSphere
Commerce toolkit provides a test environment, a workspace, and published starter
stores in WebSphere Studio Application Developer. The test environment and
workspace are customized for WebSphere Commerce development.

The initial, lightweight, WebSphere Commerce test environment provides reduced
memory requirements and application start up time. A full WebSphere Commerce
test environment is also available, providing support for more advanced
development tasks, and additional configurations.

WebSphere Commerce Payments is preconfigured into the test environment to
work with the IBM Cloudscape database. It is not exposed as a separate server but
will start silently with the test environment. As an option, the WebSphere
Commerce test environments can be configured to work with a remote WebSphere
Commerce Payments server.

If you are developing assets for more than one target, you may need to multiple
WebSphere Commerce workspaces. To obtain multiple WebSphere Commerce
workspaces, install the WebSphere Commerce toolkit multiple times.

Test environments in WebSphere Commerce Developer

There are two test environments available in WebSphere Commerce Developer:

+ |“Lightweight WebSphere Commerce test environment”|

* [“Full WebSphere Commerce test environment” on page 12|

Lightweight WebSphere Commerce test environment

The initial installation of WebSphere Commerce Developer provides a fully
functioning WebSphere Commerce development environment that includes a
lightweight WebSphere Commerce test environment that initially uses IBM
Cloudscape as the WebSphere Commerce database. You can also switch the
development database to use DB2 Universal Database or Oracle9i Database. The
lightweight test environment always uses the development database.

For more information on the databases supported by the lichtweight test
environment, refer to [“Databases supported by the test environments” on page 12|

You should use the lightweight WebSphere Commerce test environment if any of
the following statements apply to your development needs:

* You have less than 1 Gigabyte of memory on your system.

* You are working on a simple implementation of a WebSphere Commerce
application.

* You are developing JSP templates, commands or data beans for your WebSphere
Commerce application.

* You are developing enterprise beans that do not require you to write database
specific SQL statements.

© Copyright IBM Corp. 1996, 2005 11



Full WebSphere Commerce test environment

After installing WebSphere Commerce Developer, you can switch the development
database from Cloudscape to DB2 Universal Database or Oracle9i Database.
Whenever you use DB2 Universal Database or Oracle9i Database as the
development database, the full test environment is available in the WebSphere
Commerce development environment.

For more information on the databases supported by the full test environment,
refer to [“Databases supported by the test environments.”|

You should use the full WebSphere Commerce test environment if any of the
following statements apply to your development needs:

* You are developing enterprise beans that require you to write database specific
SQL.

* You are making significant changes to the database schema

* Your application requires additional data sources beyond those used by
WebSphere Commerce.

* You are developing against the dynamic cache APIs.

* You are developing code that requires WebSphere Application Server extensions
to the servlet container.

* You are developing stateful session beans.

* You are working on performance issues.

Databases supported by the test environments

When you switch the development database to either DB2 Universal Database or
Oracle9i Database, both the lightweight test environment and the full test
environment will use that database.

The WebSphere Commerce test environments can use the following databases,
depending on the edition of WebSphere Commerce Developer you are using:

Edition Lightweight Test Environment Full Test Environment
LIEEEM « IBM Cloudscape + IBM DB2 Universal Database
« IBM DB2 Universal Database Enterprise Server Edition Version
Enterprise Server Edition Version 8.15
8.1.5 * Oracle9i Database Release 2
* Oracle9i Database Release 2
+ IBM Cloudscape  IBM DB2 Universal Database
« IBM DB2 Universal Database Enterprise Server Edition Version
Enterprise Server Edition Version 8.15
8.1.5 * Oracle9i Database Release 2
* Oracle9i Database Release 2
BT - BM Cloudscape » IBM DB2 Universal Database
« IBM DB2 Universal Database Enterprise Server Edition Version
Enterprise Server Edition Version 8.15
8.1.5 * IBM DB2 Universal Database Express

« IBM DB2 Universal Database Express ~ Edition Version 8.1.5
Edition Version 8.1.5

The supported databases have only been tested running on Microsoft Windows
for use with WebSphere Commerce Developer. While it may be possible to use
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the supported databases running on operating systems other than Microsoft
Windows, such configurations have not been tested and are not supported by
IBM.

Projects provided by WebSphere Commerce Developer

The WebSphere Commerce development environment provides the following
WebSphere Studio Application Developer projects:

CommerceAccelerator
The Web module for the WebSphere Commerce Accelerator. The
WebSphere Commerce Accelerator tools can be customized by creating and
modifying assets in this web module.

OrganizationAdministration
The Web module for the WebSphere Commerce Organization
Administration Console. The Organization Administration Console can be
customized by creating and modifying assets in this web module.

SiteAdministration
The Web module for the WebSphere Commerce Administration Console.
The Administration Console can be customized by creating and modifying
assets in this web module.

Stores The Web module for WebSphere Commerce stores. Stores can be
customized by creating and modifying assets in this web module.

Servers
This server project contains the server configuration that is shared by the
lightweight and full test environments.

WebSphereCommerceServerExtensionsData
This EJB module is initially empty and is used to create custom enterprise
beans.

WebSphereCommerceServerExtensionsLogic
This Java project is initially empty and is used to create new Java classes.
Classes created in this project will be visible to both the lightweight and
full test environments.

If you are working on JSP files or web content, make your changes in the
appropriate web project. You can add new enterprise beans to the
WebSphereCommerceServerExtensionsData project.

These projects cannot be added manually to an existing workspace you may have.
The projects are only provided in the workspace that is created when installing
WebSphere Commerce toolkit

Starter stores in WebSphere Commerce Developer

You can publish any of the starter stores in WebSphere Commerce Developer.
However, if you use Cloudscape and the lightweight WebSphere Commerce test
environment, all of the starter stores provided with your edition of WebSphere
Commerce Developer are prepublished. For more information on the starter stores
available when using Cloudscape and the lightweight WebSphere Commerce test
environment, refer to [“Starter stores provided when using Cloudscape” on page 14

If you switch the development database from Cloudscape to DB2 Universal
Database or Oracle9i Database, no starter stores are initially available. You must
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publish the starter stores using the WebSphere Commerce Administration Console
following the procedures for publishing starter stores outlined in the WebSphere
Commerce Information Center.

Starter stores provided when using Cloudscape

All WebSphere Commerce starter stores are published and available in the
lightweight WebSphere Commerce test environment using Cloudscape after
installing WebSphere Commerce Developer.

The following starter stores are available when using Cloudscape as the
development database:

WebSphere Starter stores provided

Commerce Developer

edition

> Business | + Consumer Direct an example of an online consumer direct store.

e Advanced B2B Direct, an example of an advanced online B2B
direct store.

¢ Commerce Hosting Hub, an example of an online hosting
business.

¢ Commerce Plaza, an example of an online value chain, demand
chain.

¢ Commerce Supplier Hub, an example of an online value chain,
supply chain.

+ Consumer Direct, an example of an online consumer direct store.
* B2B Direct, an example of an online B2B direct store.

ET * Consumer Direct, an example of an online consumer direct store.

* B2B Direct, an example of an online B2B direct store.

For more information on the WebSphere Commerce starter stores, refer to the
WebSphere Commerce Information Center.

If you decide that you do not want all of the starter stores in your
Cloudscape-based development environment you can reset the WebSphere
Commerce database to its bootstrap configuration and then use the WebSphere
Commerce Administration Console to publish only those starter stores that interest
you.

When you reset the Cloudscape development database, store assets are not
removed from the WebSphere Commerce development environment workspace. In
order to keep the assets in the workspace synchronized with the database
following a database reset, you can use the resetstores.bat utility to remove the
prepublished stores from the workspace.

Information on resetting the database and workspace is provided in the WebSphere
Commerce Information Center.
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Pre-installation requirements

Before installing WebSphere Commerce Developer, ensure that your machine meets
the following hardware and software prerequisites.

Prerequisite hardware

Ensure that the machine on which you want install WebSphere Commerce
Developer meets the following requirements before installing WebSphere

Commerce Developer:

Minimum hardware

Recommended hardware for
using the lightweight test
environment

Recommended hardware for
using the full test
environment

Intel® Pentium® II processor

Intel Pentium III 500 MHz
processor or higher

Intel Pentium III 500 MHz
processor or higher

512 MB RAM

768 MB RAM

1 GB RAM

4.0 GB hard drive space
broken down as follows:

WebSphere Studio
Application Developer
2.1 GB

WebSphere Commerce
toolkit 1.9 GB

4.0 GB hard drive space
broken down as follows:

WebSphere Studio
Application Developer
21 GB

WebSphere Commerce
toolkit 1.9 GB

4.0 GB hard drive space
broken down as follows:

WebSphere Studio
Application Developer
2.1 GB

WebSphere Commerce
toolkit 1.9 GB

800 x 600 display resolution

1024 x 768 display resolution

1024 x 768 display resolution

CD-ROM drive

CD-ROM drive

CD-ROM drive

Prerequisite software

You must ensure that you meet the following minimum software requirements
before installing WebSphere Commerce Developer:

Operating system requirements
One of the following operating systems:

* Microsoft Windows 2000 Professional Edition with Service Pack 3 (or

higher) applied

* Microsoft Windows 2000 Server Edition with Service Pack 3 (or higher)

applied

e Microsoft Windows 2000 Advanced Server Edition with Service Pack 3
(or higher) applied

e Microsoft Windows XP Professional

Microsoft Windows Server 2003 is not supported by WebSphere Commerce

Developer.

Web browser requirements

In order to use the WebSphere Commerce tools, you must have Microsoft
Internet Explorer 6.0 Service Pack 1 or higher with the latest critical
security updates installed.

© Copyright IBM Corp. 1996, 2005
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Prior versions of Internet Explorer do not support the full function of the
WebSphere Commerce tools.

Network configuration requirements

In addition to the hardware and software requirements , ensure that the network
configuration of the system meets the following requirements:

* The system must have a resolvable domain name.

The host name combined with the domain name is the fully qualified host name.
For example, if the host name is systeml and the domain is ibm. com, the fully
qualified host name is systeml. ibm. com.

Issuing the following command from a command prompt session should return
the IP address of the system:

nslookup 'fully qualified _host_name'

The desired result is a reply with the correct IP address of the system.

* The IP address on the system must resolve to a host name (including a domain).
To determine if the IP address is mapped to a fully qualified host name, start a
command prompt session and issue the following command:

nslookup 'IP_address'

The desired result is a reply with the correct fully qualified host name of the
system.

* Ensure that the system can be reached from other computers in the network by
pinging the fully-qualified host name of the machine on which you are installing
WebSphere Commerce Developer.
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Part 3. Installing WebSphere Commerce Developer

Installing WebSphere Commerce Developer is a four-step process:
Step 1. Install WebSphere Studio Application Developer, Version 5.1.2

For instructions, refer to IBM WebSphere Studio Application Developer for
Windows and Linux® Installation Guide available on the WebSphere Studio
Application Developer CDs as the file install.pdf.

— Important installation instructions
When installing WebSphere Studio Application Developer, Version
5.1.2 ensure that you do the following:

* Ensure that you are logged on as a user with Administrator
privileges.

* Do not accept the default installation path for WebSphere Studio
Application Developer, Version 5.1.2. Specify a short directory
name such as C:\WSAD512.

The default installation path is too long for configuration with the
WebSphere Commerce toolkit.

non

Also, avoid using periods ("."), spaces, or dollar signs ("$") in the
directory names.

* When prompted to select the features to install, ensure that you
select Integrated Test Environments > WebSphere Application
Server 5.1.

Step 2. Apply WebSphere Studio Application Developer fixes.

For instructions, refer to [“Applying fixes to WebSphere Studio Application|
[Developer” on page 19/

Step 3. If you plan to use the full test environment, you must apply WebSphere
Application Server fixes to the WebSphere Application Server 5.1 Test
Environment in WebSphere Studio Application Developer.

For instruction, refer to|“Applying fixes to the WebSphere Application|
[Server 5.1 Test Environment” on page 21|

Step 4. Install the WebSphere Commerce toolkit.

For instructions, refer to [“Installing the WebSphere Commerce toolkit” on|

© Copyright IBM Corp. 1996, 2005 17



18 WebSphere Commerce Developer Installation Guide



Applying fixes to WebSphere Studio Application Developer

Apply WebSphere Studio Application Developer fixes as follows:

1.

S < A

Open WebSphere Commerce Developer by selecting Start > Programs > IBM
WebSphere Commerce Developer Business Edition 5.7 > WebSphere
Commerce development environment.

Select Help > Software Updates > New updates.
Click Select All and click Next.

Accept the license agreement and click Finish.
Follow the prompts to install all of the updates.

© Copyright IBM Corp. 1996, 2005
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Applying fixes to the WebSphere Application Server 5.1 Test
Environment

Prerequisites

* The machine on which you are installing meets all prerequisites outlined in
[“Pre-installation requirements” on page 15

* You have installed WebSphere Studio Application Developer, Version 5.1.2 with
WebSphere Application Server 5.1 Test Environment on the machine.

For instructions, refer to IBM WebSphere Studio Application Developer for Windows
and Linux Installation Guide available on the WebSphere Studio Application
Developer CDs.

* You have stopped any applications running on your machine.

* You are logged on as a user with Administrator privileges.
Procedure

To apply WebSphere Application Server fixes to the WebSphere Application Server
5.1 Test Environment in WebSphere Studio Application Developer, do the
following:

1. Insert the WebSphere Application Server Fixes CD from your WebSphere
Commerce package provided with WebSphere Commerce Developer into the
CD-ROM drive of the machine where you have WebSphere Studio Application
Developer installed.

2. Prepare the update installation wizard as follows:

a. From the WebSphere Application Server Fixes CD, copy the
updateInstaller directory to a temporary location on the hard drive.

b. Start a command prompt session.
c. Do the following in the command prompt session:
1) Change directories to the updateInstaller directory on the hard drive.
2) Issue the following command:
WSAD_installdir\runtimes\base_v5I1\bin\setupCmdLine
3) Start the update installation wizard by issuing the following command:
updateWizard

You can close the command prompt session at this point.

d. When prompted to select the product to update, select Specify product
information and enter the following path in the Installation directory field:

WSAD_installdir\runtimes\base_v51

Click Next.
e. Leave the update installation wizard open for the next step.

3. Apply WebSphere Application Server Version 5.1 Fix Pack 1 to your WebSphere
Studio Application Developer installation as follows:

The update installation wizard should still be open from the previous step.
a. Select Install fix packs and click Next.
b. In the Fix pack directory field, enter the following path:

CD-ROM drive:\BASE\fixpack
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Click Next.

Ensure that was51_fp1_win is selected and click Next.

Deselect Embedded Messaging and click Next.

Continue through the update installation wizard until the installation starts.
When the installation has completed, click Run Wizard Again.

This will leave the update installation wizard open to apply the required
cumulative fix in the next step.

4. Apply WebSphere Application Server Version 5.1.1 Cumulative Fix 3 to your
WebSphere Studio Application Developer installation as follows:

The update installation wizard should still be open from the previous step.

a.
b.

Select Install fix packs and click Next.
In the Fix pack directory field, enter the following path:
CD-ROM drive:\BASE\fixpack

Click Next.
Ensure that was511_cf3_win is selected and click Next.

. Continue through the update installation wizard until the installation starts.

e. When the installation has completed, click Run Wizard Again.

This will leave the update installation wizard open to apply the require
interim fixes in the next step.

5. Apply the WebSphere Application Server interim fixes to your WebSphere
Studio Application Developer installation as follows:

The update installation wizard should still be open from the previous step.

a.
b.

@ ~o oo

h.

Select Install fixes and click Next.
In the Fix directory field, enter the following path:
CD-ROM drive:\WCDE_fixes

Click Next.

From the list of available fixes, select JDKiFix_win and click Next.
Continue through the update installation wizard until the installation starts.
When the installation has completed, click Run Wizard Again.

Select Install fixes and click Next.

In the Fix directory field, enter the following path:

CD-ROM drive:\BASE\fixes

Click Next.
From the list of available fixes, select PQ99045 and click Next.

Continue through the update installation wizard until the installation starts.

6. When the update installation wizard completes, click Finish.
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Installing the WebSphere Commerce toolkit

Prerequisites:

* The machine on which you are installing meets all prerequisites outlined in
[“Pre-installation requirements” on page 15

* You have installed WebSphere Studio Application Developer, Version 5.1.2 with
the WebSphere Application Server 5.1 Test Environment on the machine.

For instructions, refer to IBM WebSphere Studio Application Developer for Windows
and Linux Installation Guide available on the WebSphere Studio Application
Developer CDs.

* You have stopped any applications running on your machine.

* You are logged on as a user with Administrator privileges.
Procedure:

To install the WebSphere Commerce toolkit, do the following:

1. Insert WebSphere Commerce Developer CD in the CD-ROM of the WebSphere
Studio Application Developer machine.

The WebSphere Commerce toolkit installation wizard should start
automatically.

If the WebSphere Commerce toolkit installation does not start automatically,
run setup.exe on the root of the WebSphere Commerce Developer CD.

2. Follow the instructions provided in the wizard.
3. Ensure that the install was successful by doing the following;:

* Examine the contents of WCDE installdir\logs\setup.log. If setup.Tlog is
empty or has errors, try running WCDE_installdir\bin\setup.bat from the
command line.

¢ Check that the install was able to properly detect WebSphere Studio
Application Developer on your system by ensuring that
WCDE _installdir\bin\setenv.bat sets the WSAD_HOME environment
variable to WSAD_installdir correctly.

You now have a fully functioning WebSphere Commerce development
environment installed. This WebSphere Commerce development environment
provides a lightweight WebSphere Commerce test environment that uses IBM
Cloudscape as the WebSphere Commerce database.

© Copyright IBM Corp. 1996, 2005 23



24 WebSphere Commerce Developer Installation Guide



Next step

After installing all of the components of WebSphere Commerce Developer, you can
continue by doing any of the optional tasks provided in [Part 4, “Configuring]
[WebSphere Commerce Developer,” on page 27
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Part 4. Configuring WebSphere Commerce Developer

The chapters in this section describe how to perform any of the optional
configurations for WebSphere Commerce Developer beyond the initial
configuration when you install WebSphere Commerce Developer. Topics covered in
this section include:

+ |“Adding the full WebSphere Commerce test environment to the WebSphere|
Commerce development environment” on page 29|

+ [“Changing the development database” on page 31|

+ |“Configuring payment processing in WebSphere Commerce Developer” on page|
59
+ [“Configuring additional WebSphere Commerce software for WebSphere|
Commerce Developer” on page 47]
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Adding the full WebSphere Commerce test environment to the
WebSphere Commerce development environment

The initial installation of WebSphere Commerce Developer provides a lightweight
WebSphere Commerce test environment using IBM Cloudscape as the WebSphere
Commerce database. A full WebSphere Commerce test environment using DB2
Universal Database or Oracle9i Database can be added after completing the initial
installation. This full WebSphere Commerce test environment is similar to the test
environment provided in WebSphere Commerce Studio Version 5.5. In some
documentation, this full WebSphere Commerce test environment may be referred
to as the "classic” test environment.

You should use the full WebSphere Commerce test environment if any of the
following statements apply to your development needs:

* You are developing enterprise beans that require you to write database specific
SQL.
* You are making significant changes to the database schema

* Your application requires additional data sources beyond those used by
WebSphere Commerce.

* You are developing against the dynamic cache APIs.

* You are developing code that requires WebSphere Application Server extensions
to the servlet container.

* You are developing code to integrate a back-end system via WebSphere MQ.
* You are developing stateful session beans.

* You are working on performance issues.

Prerequisites:
* You have installed WebSphere Studio Application Developer, Version 5.1.2.

* You applied the required fixes to WebSphere Studio Application Developer,
Version 5.1.2 as documented in [“Applying fixes to the WebSphere Application|
[Server 5.1 Test Environment” on page 21.

* You have installed the WebSphere Commerce toolkit.
* You have a functioning lightweight test environment.

Procedure:

To add the full WebSphere Commerce test environment to the WebSphere
Commerce development environment, do one of the following;:

gl Business | Configure the development environment to use DB2
Universal Database.

For instructions, refer to[’Configuring the development environment to use DB2|
[Universal Database” on page 31

gl Business | Configure the development environment to use Oracle9i
Database.

For instructions, refer to[’Configuring the development environment to use|
[Oracle9i Database” on page 34
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Changing the development database

The initial configuration of the WebSphere Commerce development environment
uses Cloudscape as the development database. However, you can switch to using
DB2 Universal Database or Oracle9i Database as the development database.

Consider the following guidelines when switching between database types:

* If you are developing session beans or custom entity bean finders that have
database-specific SQL statements, you should consider moving to using DB2
Universal Database or Oracle9i Database, as appropriate. The alternative is to
code your session beans and custom finders to examine the useCloudscape,
useDB2, useDB2_390, and useOracle methods of the Base]DBCHelper class and
then generate the database specific SQL statements.

* The effort of maintaining code that will work with Cloudscape and your target
database, must be weighed against the additional setup and configuration effort
required in setting up development environments that works directly against the
target database.

Configuring the development environment to use DB2 Universal
Database

The initial installation of WebSphere Commerce Developer provides a WebSphere
Commerce development environment that uses IBM Cloudscape as the WebSphere
Commerce database.

You should reconfigure the development environment to use DB2 Universal
Database if any of the following statements apply to your development needs:

* You are developing enterprise beans that require you to write database specific
SQL.

* You are making significant changes to the database schema

You may use either local or remote DB2 Universal Database.

Prerequisites:

* You have installed WebSphere Studio Application Developer, Version 5.1.2 with
the WebSphere Application Server 5.1 Test Environment.

* If you plan to use the full WebSphere Commerce test environment, you have
applied the required fixes to WebSphere Studio Application Developer as
documented in [ Applying fixes to the WebSphere Application Server 5.1 Test]
[Environment” on page 21

* You have installed the WebSphere Commerce toolkit and have a functioning
lightweight test environment.

gl Business You have installed IBM DB2 Universal Database Enterprise
Server Edition Version 8.1.5 on a local or remote Windows machine.
Ensure the Application Development Tools component is installed.

- EETEM You have installed IBM DB2 Universal Database Enterprise Server

Edition Version 8.1.5 or IBM DB2 Universal Database Express Edition Version
8.1.5 on a local or remote Windows machine.

Ensure the Application Development Tools component is installed.
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 If you are using a remote DB2 Universal Database database server, you have
installed the DB2 Universal Database Administration Client on the WebSphere
Commerce development environment machine.

* You have the following information gathered about your database server:

Local DB2 Universal Database Remote DB2 Universal Database

* The root directory of DB2 Universal * The root directory of the DB2 Universal
Database Database client
For example, C:\SQLLIB For example, C:\SQLLIB

¢ The database administrator ID * The database administrator ID

* The database administrator password The database administrator password

e The database user ID (schema owner ID) The database user ID (schema owner ID)
* The database user password * The database user password

* The fully qualified host name of the
database server

e The port number on the database server
used for remote connections

* The node name of the remote database

Procedure:

To configure the development environment to use DB2 Universal Database, do the
following:

1. Ensure that WebSphere Studio Application Developer is not running.

Note: If you forget to shut down WebSphere Studio Application Developer, the
server configuration may disappear. Refresh the Servers project and it
should reappear.

2. If you have an existing, remote WebSphere Commerce, Version 5.7 development
database that you want to use, do the following on your WebSphere Commerce
Developer machine the first time you switch to the existing database:

a. Catalog the remote database node.

b. Catalog the remote database.

For information on how to catalog a remote database node and how to catalog
a remote database, refer to the DB2 Information Center at the following URL:
|http://publib.boulder.ibm.com/infocenter/db2help/index. jsp|

Once a remote database node and a remote database are cataloged on machine,
they will not have to be cataloged again. You can switch to the cataloged
remote database without repeating this step.

3. Start a command prompt session.
4. Switch directories to the WCDE_installdir\bin directory.
5. Issue the following command:

setdbtype db2 DB2 _HOME dbName dbAdminID dbAdminPassword dbUserID
dbUserPassword [dbHost dbServerPort dbNode]

where the command parameters are defined as follows:
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DB2_HOME
The root directory of DB2 Universal Database or the DB2 Universal
Database client, depending on if you are using a local or remote
database.

For example, C:\SQLLIB.

dbName
The name of the database you want to use with WebSphere Commerce
Developer.

If this is the first time you are switching database, this is the name you
want to give the database that will be created in the next step.

dbAdminID
The database administrator ID.

dbAdminPassword
The database administrator password.

dbUserID
The database user ID (schema owner).

dbUserPassword
The database user password.

dbHost Remote database only: The fully qualified host name of the database
server.

dbServerPort
Remote database only: The port number on the database server used
for remote connections.

dbNode
Remote database only: The node name of the remote database.

. If this is the first time you are configuring the development environment to use
DB2 Universal Database and you are not using an existing, remote WebSphere
Commerce, Version 5.7 development database, issue the following command
from a DB2 command window

createdb.db2 dbName userId password schemaowner
[servername serverport nodename]

where the command parameters are defined as follows:

dbname
The name of the database to create and populate for WebSphere
Commerce Developer.

This name must match the name you used with the setdbtype
command.

userID The database user ID.

password
The database user password.

schemaowner
The user ID that is the schema owner for the development database.
This is usually the same as the database user ID

servernarme
Remote database only: The fully qualified host name of the database
server.
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serverport
Remote database only: The port number on the database server used
for remote connections.

nodename
Remote database only: The node name of the remote database.

This utility creates and populates the DB2 Universal Database development
database.

The WebSphere Commerce development environment is now configured to use
DB2 Universal Database as its database. Also, the full test environment has been
added to the WebSphere Commerce development environment. Both the
lightweight WebSphere Commerce test environment and the full WebSphere
Commerce test environment use the DB2 Universal Database development
database.

All data in the Cloudscape database remains unchanged until you return to using
Cloudscape as the development database.

The new DB2 Universal Database development database does not come with all
starter stores published. You must publish any starter stores you want to work
using the WebSphere Commerce Administration Console. For more information on
publishing starter stores, refer to the WebSphere Commerce Information Center.

Configuring the development environment to use Oracle9i Database

— Edition notice
Oracle9i Database is supported by WebSphere Commerce Developer Business
Edition and WebSphere Commerce Developer Professional Edition.

Oracle9i Database is not supported by WebSphere Commerce - Express
Developer Edition.

The initial installation of WebSphere Commerce Developer provides a WebSphere
Commerce development environment that uses IBM Cloudscape as the WebSphere
Commerce database.

You should reconfigure the development environment to use Oracle9i Database if
any of the following statements apply to your development needs:

* You are developing enterprise beans that require you to write database specific
SQL.

* You are making significant changes to the database schema

Prerequisites:

* You have installed WebSphere Studio Application Developer, Version 5.1.2with
the WebSphere Application Server 5.1 Test Environment.

* If you plan to use the full WebSphere Commerce test environment, you have
applied the required fixes to WebSphere Studio Application Developer as
documented in [“ Applying fixes to the WebSphere Application Server 5.1 Test|
[Environment” on page 21

* You have installed the WebSphere Commerce toolkit and have a functioning
lightweight test environment.
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* You have installed Oracle9i Database Release 2 on a local or remote Windows
machine. The following table lists the components you should install for a local

and a remote Windows machine:

Local Oracle9i Database

Remote Oracle9i Database

* Oracle9i Database

* Oracle Net Services

* Oracle Net Protocol Support
* SQL*Plus

* Oracle JDBC/Thin Interfaces
* Oracle JDBC/OCI Interfaces

Database server machine

* Oracle9i Database

* Oracle Net Services

e Oracle JDBC/Thin Interfaces

* Oracle J]DBC/OCI Interfaces
WebSphere Commerce Developer
machine

* Oracle9i Enterprise Client

* SQL*Plus

* Oracle ]DBC/Thin Interfaces

* Oracle JDBC/OCI Interfaces

» Oracle Network Utilities

* Oracle Database Utilities

Ensure that the Oracle client and server are
configured to communicate correctly
according to instructions found in the
Oracle9i Database Database documentation.

For instructions on installing these components, refer to your Oracle9i Database

documentation.

* You have created an Oracle user ID and an empty database. Ensure that the
database uses the UTF-8 code set and that the Oracle user ID has access to the

new database.

For instructions on creating a database, refer to your Oracle9i Database

documentation.

* You have gathered the following information about Oracle9i Database:

Local Oracle9i Database

Remote Oracle9i Database

* The root directory of Oracle9i Database
For example, C:\ORACLE\ORA92

e The name of the database

* The database administrator ID

* The database administrator password

* The database user ID

* The database user password

The root directory of Oracle9i Database
client

For example, C:\ORACLE\ORA92
* The name of the remote database

* The name of the local net service for the
remote database

* The database administrator ID

* The database administrator password
* The database user ID

¢ The database user password

* The fully qualified host name of the
database server

* The port number on the database server
used for remote connections

Procedure:

Changing the development database 35



To configure the development environment to use Oracle9i Database, do the
following:

1. Ensure that WebSphere Studio Application Developer is not running.
2. Start a command prompt session.

3. Switch directories to the WCDE_installdir\bin directory.

4. Issue the following command:

setdbtype oracle ORACLE_HOME dbName dbAdminID dbAdminPassword dbUserID
dbUserPassword [dbHost dbServerPort]

where the command parameters are defined as follows:

ORACLE_HOME
The root directory of Oracle9i Database or the database client,
depending on if you have a local or a remote database.

For example, C:\ORACLE\ORA92.

dbName
The name of the database to use with WebSphere Commerce Developer.

If you are using a remote database, this is the name of the database on
the remote database server.

dbAdminID
The database administrator ID.

dbAdminPassword
The database administrator password.

dbUserID
The database user ID.

dbUserPassword
The database user password.

dbHost Remote database only: The fully qualified host name of the database
server.

dbServerPort
Remote database only: The port number on the database server used
for remote connections.

5. Issue the following command:
createdb.oracle dbname userID password schemaowner

where the command parameters are defined as follows:

dbname
The name of the database to populate for WebSphere Commerce
Developer.

If you are using a local database, this name must match the name you
used with the setdbtype command.

If you are using a remote database, this is the name of the local net
service created to map to the remote database service.

userID The Oracle ID used to access the database.

password
The Oracle user password.
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schemaowner
The Oracle tablespace owner for the development database. This is
usually the same as the Oracle user ID used to access the database.

This utility populates the Oracle9i Database development database.

The WebSphere Commerce development environment is now configured to use
Oracle9i Database as its database. Also, the full WebSphere Commerce test
environment has been added to the WebSphere Commerce development
environment. Both the lightweight test environment and the full WebSphere
Commerce test environment use the Oracle9i Database development database.

All data in the Cloudscape database remains unchanged until you return to using
Cloudscape as the development database.

The new Oracle9i Database development database does not come with all starter
stores published. You must publish any starter stores you want to work using the
WebSphere Commerce Administration Console. For more information on
publishing starter stores, refer to the WebSphere Commerce Information Center.

Configuring the development environment to use Cloudscape

If you are using DB2 Universal Database or Oracle9i Database you can return to
using Cloudscape as the development database.

Prerequisites:

* The WebSphere Commerce development environment uses DB2 Universal
Database or Oracle9i Database for the development database.

Procedure:

To configure the development environment to use Cloudscape, do the following:
1. Ensure that WebSphere Studio Application Developer is not running.
2. Start a command prompt session.
3. Switch directories to the WCDE_installdir\bin directory.
4. Issue the following command:
setdbtype cloudscape

The WebSphere Commerce development environment is now configured to use
IBM Cloudscape as its database. Also, the full test environment has been removed
from the WebSphere Commerce development environment.

All data in the DB2 Universal Database or Oracle9i Database database remains

unchanged until you return to using the DB2 Universal Database or Oracle9i
Database database as the development database.
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Configuring payment processing in WebSphere Commerce
Developer

WebSphere Commerce Payments is preconfigured into the test environments. It is
not exposed as a separate server but will start silently with the test environments.
The test environments can also be configured to work with a remote payment
server.

Only the OfflineCard cassette is enabled in the test environment. If you would like
to use the 3-D Secure Merchant Plug-in with the VisaNet or Paymentech cassettes,
the WebSphere Commerce development environment must be configured to use a
remote WebSphere Commerce Payments server that has the VisaNet or
Paymentech cassette configured.

Configuring the development environment to use WebSphere
Commerce Payments on the development machine

WebSphere Commerce Payments is configured on the development machine when
WebSphere Commerce Developer is installed. After installing WebSphere
Commerce Developer, you must configure payment methods in WebSphere
Commerce Payments. For more details, refer to [‘Configuring accepted payment|
[methods in WebSphere Commerce Payments” on page 42

WebSphere Commerce Payments starts silently with the test environment.

If you want to configure the development environment to use WebSphere
Commerce Payments on a remote machine, follow the instructions in |”Configuring
the development environment to use WebSphere Commerce Payments on a remote

machine. ”|

If you have configured the development environment to use WebSphere Commerce
Payments on a remote machine and you want to return to using WebSphere
Commerce Payments on the development machine, follow the instructions in
“Switching from remote WebSphere Commerce Payments to local WebSphere
Commerce Payments” on page 44

Configuring the development environment to use WebSphere
Commerce Payments on a remote machine

Before you can configure your development environment to use a remote
WebSphere Commerce Payments, you must install and configure WebSphere
Commerce Payments on a machine separate from your development machine.

To configure the development environment to use WebSphere Commerce Payments
on a remote machine, do the following:

Step 1. Install and configure WebSphere Commerce Payments on the remote
machine. For more instructions, refer to[“Installing and configuring|
[WebSphere Commerce Payments” on page 40|

Step 2. Configure the WebSphere Commerce development environment to use a
remote WebSphere Commerce Payments. For more details, refer to
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“Configuring the WebSphere Commerce development environment to use|
remote WebSphere Commerce Payments” on page 41

Step 3. Configure payment methods in WebSphere Commerce Payments. For
more details, refer to|‘Configuring accepted payment methods in|
[WebSphere Commerce Payments” on page 42

If you have configured the development environment to use WebSphere Commerce
Payments on a remote machine and you want to return to using WebSphere
Commerce Payments on the development machine, follow the instructions in
“Switching from remote WebSphere Commerce Payments to local WebSphere
Commerce Payments” on page 44

Installing and configuring WebSphere Commerce Payments
Prerequisites:

* The machine on which you are installing WebSphere Commerce Payments meets
all prerequisites outlined in WebSphere Commerce Installation Guide.

Procedure:

To install and configure WebSphere Commerce Payments on a machine separate
from your development machine, do the following:

1. Complete a custom installation of WebSphere Commerce on the remote
machine. During the installation, select the following components when
completing the custom installation:
¢ WebSphere Commerce Payments, including WebSphere Application Server

base product

* IBM HTTP Server, including WebSphere Application Server plug-in

Instructions for completing a custom installation are provided in WebSphere
Commerce Installation Guide.

2. Create a WebSphere Commerce Payments instance by following the instructions
in WebSphere Commerce Installation Guide.

When completing the WebSphere Commerce Payments instance creation
wizard, certain fields require specific values as follows:

Site Admin ID
Enter wcsadmin.

This is the Site Administrator ID in the WebSphere Commerce
development environment test environments and must be the same in
the WebSphere Commerce Payments.

Commerce Webserver Hostname
Enter the fully qualified host name of the WebSphere Commerce
Developer machine in this field on the WCSRealm panel of the
Payments Instance Creation wizard.
Also, ensure that you use specify a unique database name — if the database
name already exists, instance creation will fail. The default name for the
WebSphere Commerce Payments database is WPM.

3. Start IBM HTTP Server according to the IBM HTTP Server documentation.

4. Start WebSphere Commerce Payments by following the instructions in
WebSphere Commerce Information Center.

5. Ensure that you can connect to WebSphere Commerce Payments from the
WebSphere Commerce Developer machine by opening the following URL:

http://hostname:5432/webapp/PaymentManager
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or
https://hostname:5433/webapp/PaymentManager

where the variables are defined as follows:

hostname
The fully qualified TCP/IP host name of the Web server associated
with WebSphere Commerce Payments. In this case, it would be the
same host name as the WebSphere Commerce Payments machine.

If WebSphere Commerce Payments is SSL-enabled, use the secure (https) URL.
Otherwise, use the non-secure (http) URL.

If you see the IBM WebSphere Commerce Payments Logon page, your
configuration of the remote WebSphere Commerce Payments machine was
successful.

Configuring the WebSphere Commerce development
environment to use remote WebSphere Commerce Payments

Prerequisites:

* The WebSphere Commerce development environment is running.

 All test environments are stopped.

* WebSphere Commerce Payments is installed on the remote Payments machine.

* A WebSphere Commerce Payments instance exists on the remote Payments

machine.

Procedure:

To configure the WebSphere Commerce development environment to use a remote
WebSphere Commerce Payments, do the following on the WebSphere Commerce
Developer machine:

1.

Stop any WebSphere Commerce test environments that may be running in
WebSphere Studio Application Developer.

In the J2EE Hierarchy view in WebSphere Studio Application Developer,
expand Servers and double-click one of the following:

* Full WebSphere Commerce Test Environment

This server is only available if you have added the full WebSphere
Commerce test environment to the WebSphere Commerce development
environment by following the instructions in[“Adding the full WebSphere
Commerce test environment to the WebSphere Commerce development|
environment” on page 29|

* Lightweight WebSphere Commerce Test Environment

The test environment view for the test environment you double-clicked
displays.

In the test environment view, select the Configuration page.

On the Configuration page, expand Payments and fill in the fields as follows:

Hostname
Enter the fully qualified host name of the WebSphere Commerce
Payments machine. This field defaults to Tocalhost. If you have
installed WebSphere Commerce Payments on a remote machine, you
must ensure that this field contains the fully qualified host name of the
WebSphere Commerce Payments machine. If WebSphere Commerce
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Payments and the Web server it uses are on separate machines then
enter the fully qualified host name of the Web server machine.

Profile Path
Ensure the path is the following:

../conf/xml/payment

Use non-SSL Payments Client
Select this check box if you want WebSphere Commerce Developer to
use the non-Secure Sockets Layer (SSL) WebSphere Commerce
Payments client to communicate with the WebSphere Commerce
Payments server. This allows the WebSphere Commerce Server in the
WebSphere test environment to communicate with WebSphere
Commerce Payments without using SSL.

Webserver Port
Enter the TCP port number of the Web server that WebSphere
Commerce Payments uses. If you have enabled Use non-SSL

WebSphere Commerce Payments client the default value for this field is

5432. If this check box has not been selected, the default value for this
field is 5433 (the SSL port).

Use Socks Server
Enable this check box if WebSphere Commerce Developer must go
through a socks server in order to reach WebSphere Commerce
Payments.

Socks Hostname
Enter the fully-qualified host name of your socks server. This field is
only available if the Use Socks Server check box is enabled.

Socks Port Number
Enter the port number that your socks server uses. This field is only
available if the Use Socks Server check box is enabled.

5. Select File > Save to save your changes.

Configuring accepted payment methods in WebSphere Commerce

Payments

Before enabling the WebSphere Commerce Payments for use with WebSphere
Commerce in the WebSphere test environment you must configure the payment
methods accepted by a store.

When you a publish a starter store, a number of sample payment methods are
automatically configured and the instructions in this section can be skipped.
However, you should complete these steps after publishing a starter store if you
find the starter store does not contain payment methods you would like to test.

To configure WebSphere Commerce Payments, do the following:

1. Start one of the WebSphere Commerce test environments in WebSphere Studio

Application Developer.
2. If you are using remote WebSphere Commerce Payments, start WebSphere
Commerce Payments.

For instructions on how to start WebSphere Commerce Payments, refer to the
WebSphere Commerce Information Center.

3. Open the WebSphere Commerce Payments console using one of the following
URLs:

42 WebSphere Commerce Developer Installation Guide



10.

11.

WebSphere Commerce Payments on the development machine
https://hostname/webapp/PaymentManager/PaymentServerUI/Start

where hostname is the fully qualified host name of the WebSphere
Commerce Developer machine. If you are accessing WebSphere
Commerce Payments console directly from the WebSphere Commerce
Developer machine, you can use lTocalhost as the host name.

Log on to WebSphere Commerce Payments using wcsadmin as both the
ID and password.

WebSphere Commerce Payments on a remote machine using the non-SSL
port  Use the following URL if WebSphere Commerce Payments is not
SSL-enabled:

http://hostname:5432/webapp/PaymentManager

where hostname is the fully qualified host name of the WebSphere
Commerce Payments

Log on to WebSphere Commerce Payments using wcsadmin as both the
ID and password.

WebSphere Commerce Payments using the SSL port
Use the following URL if WebSphere Commerce Payments is
SSL-enabled:

https://hostname:5433/webapp/PaymentManager

where hostname is the fully qualified host name of the WebSphere
Commerce Payments machine.

Log on to WebSphere Commerce Payments using wcsadmin as both the
ID and password.

From the left panel, click Merchant Settings.

Click Refresh to see what merchant was added after you have published a
starter store.

In the right window, click Add a Merchant.

Enter a Merchant Name for your starter store. The Merchant Number must be
the same as the storeld for your starter store (e.g. 10001). Select the
OfflineCard check box and click Create Merchant. A "Merchant created
successfully” message should appear.

Note: If a merchant already exists for your storelD, you cannot create another
merchant for the same storelD.

In the left panel, click Merchant Settings again. In the right hand window,
beside the name of your new merchant, the green cassette status icon (under
the OfflineCard column) indicates that the OfflineCard cassette is enabled and
running for that merchant. Click the green icon. You must now create an
account for each currency supported by your store, by clicking Accounts.

Click Add an Account. Enter an Account Name and an Account Number. The
account number must be unique within that store. Select the appropriate
currency from the drop-down menu. Click Create Account.

In the Accounts window, click the name of your new account, then click
Brands.

Click Add a Brand. Enter a Brand Name (e.g. VISA) and click Create Brand.
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12. Repeat for all other Brands to be used with this account. Repeat the above
three steps to add accounts for all other currencies to be supported by your
store.

If you are using remote WebSphere Commerce Payments and you want to use any
other WebSphere Commerce Payments cassettes with, refer to the documentation
for the cassette for configuration instructions. Documentations for cassettes is
available through the WebSphere Commerce library.

Switching from remote WebSphere Commerce Payments to local
WebSphere Commerce Payments

Follow the instructions in this section if you have configured the development
environment to use WebSphere Commerce Payments on a remote machine and you
want to return to using WebSphere Commerce Payments on the development
machine.

Prerequisites:
* The WebSphere Commerce development environment is running.

 All test environments are stopped.
Procedure:

To return to using WebSphere Commerce Payments on the WebSphere Commerce
development environment machine, do the following:

1. Stop any WebSphere Commerce test environments that may be running in
WebSphere Studio Application Developer.

2. In the J2EE Hierarchy view in WebSphere Studio Application Developer,
expand Servers and double-click one of the following:

e Full WebSphere Commerce Test Environment

This server is only available if you have added the full WebSphere
Commerce test environment to the WebSphere Commerce development
environment by following the instructions in

* Lightweight WebSphere Commerce Test Environment
The test environment view for the test environment you double-clicked
displays.

3. In the test environment view, select the Configuration page.

4. On the Configuration page, expand Payments and fill in the fields as follows:

Hostname
Enter Tocalhost.

Profile Path
Ensure the path is the following:

../conf/xml/payment

Use non-SSL Payments Client
Ensure this box is not selected.

Webserver Port
Enter 443.

Use Socks Server
Ensure this check box is not selected.
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Socks Hostname
This field should be disabled because the Use Socks Server check box
is not selected.

Socks Port Number
This field should be disabled because the Use Socks Server check box
is not selected.

5. Select File > Save to save your changes.
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Configuring additional WebSphere Commerce software for
WebSphere Commerce Developer

WebSphere Commerce provides additional software packages that you may want
to use in the WebSphere test environment. For more information on the additional
software packages provided with WebSphere Commerce, refer to theWebSphere
Commerce Additional Software Guide for the edition of WebSphere Commerce you
have.

Use the information in this section, along with theWebSphere Commerce Additional
Software Guide for the appropriate edition of WebSphere Commerce, to install and
configure the additional software packages for use with WebSphere Commerce
Developer.

In the following sections, refer to the Edition notice to see if the software
discussed is supported by your edition of WebSphere Commerce Developer.

WebSphere Commerce analytic tools

WebSphere Commerce Analyzer

Edition notice
WebSphere Commerce Analyzer is not supported by WebSphere Commerce
Developer Business Edition, WebSphere Commerce Developer Professional
Edition, or WebSphere Commerce - Express Developer Edition.

Tivoli Web Site Analyzer

Edition notice
Tivoli® Web Site Analyzer is not supported by WebSphere Commerce
Developer Business Edition, WebSphere Commerce Developer Professional
Edition, or WebSphere Commerce - Express Developer Edition.

WebSphere Commerce business integration

The business integration software packages, WebSphere MQ is not provided with
either WebSphere Commerce or WebSphere Commerce Developer. it must be
purchased separately.

WebSphere MQ

Edition notice
WebSphere MQ is supported by WebSphere Commerce Developer Business
Edition, WebSphere Commerce Developer Professional Edition, and
WebSphere Commerce - Express Developer Edition.

Prerequisites:

* You have installed the WebSphere Commerce development environment.
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* You have the full test environment added to the WebSphere Commerce
development environment.

For instructions on adding the full test environment to the WebSphere
Commerce development environment, refer to[“Adding the full WebSphere|
Commerce test environment to the WebSphere Commerce development]
environment” on page 29

You cannot use WebSphere MQ with the lightweight test environment.
Procedure:

To use WebSphere MQ (formerly MQSeries®) with WebSphere Commerce

Developer, do the following;:

1. Follow the instructions found in WebSphere Commerce Additional Software Guide
with the following changes:

* If plan to use Client mode connections to your messaging server (either
WebSphere MQ server or the embedded messaging server), ensure that you
apply the fixes listed for messaging components available at the following
URL:

|https://wwwl4.software.ibm.com/webapp/iwm/web/reg/pick.do?source=wsmqcsd|

Depending on the client you are using, obtain fixes as follows:

Embedded messaging client
Obtain and install the fixes found under WebSphere embedded
messaging interim fixes for WebSphere Application Server V5.1.1.

WebSphere MQ client
Ensure that you are at CSD08 or later.

You will need an IBM ID and password to access the fixes. If you do not
have an IBM ID or password, click My IBM registration to obtain an ID and
password.

 Skip any steps for starting WebSphere Application Server. Starting
WebSphere Application Server is not required when working in WebSphere
Commerce Developer.

 Skip any steps for starting the WebSphere Application Server node agent.
Starting the WebSphere Application Server node agent is not required when
working in WebSphere Commerce Developer.

* Launch the administration console from within WebSphere Commerce
Developer by following the instructions in [“Starting the WebSphere|
Application Server Administrative Console in the WebSphere Commerce|
development environment” on page 65|instead of opening the WebSphere
Application Server Administrative Console.

* Scope changes to the WebSphere Commerce application server by selecting
Server from list of available scopes.

You cannot scope any changes to the WebSphere Commerce application
server by entering the name of the WebSphere Commerce application server
in the Server field as this field is unavailable when the WebSphere
Application Server Administrative Console runs in the WebSphere test
environment.

* Do not perform the tasks outlined in "Determining the maximum number of
ManagedConnections for the JCA-JMS connector”.

* Do not change the value in the Max Connections field of the Connection
Pool page for the WebSphere MQ JMS Provider queue connection factory in
the administration console. Accept the default value.
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* When asked to launch the WebSphere Commerce Configuration Manager, go
to the Configuration page of either test environment view in WebSphere
Studio Application Developer and expand Transports. Complete the fields as
described in the WebSphere Commerce Additional Software Guide.

Instructions for accessing the Configuration page in WebSphere Studio
Application Developer are provided in [“Accessing the Configuration page
[for a test environment” on page 65

Using WebSphere Studio Application Developer Embedded
Messaging Server as an alternative to WebSphere MQ server
You can use the WebSphere Studio Application Developer Embedded Messaging
Server as an alternative to using WebSphere MQ server with WebSphere
Commerce development environment.

Prerequisites:

* You have installed WebSphere Studio Application Developer, Version 5.1.2 on the
machine.

For instructions, refer to IBM WebSphere Studio Application Developer for Windows
and Linux Installation Guide available on the WebSphere Studio Application
Developer CDs.

* You have the WebSphere Studio Application Developer embedded messaging
server and client installed.

This is installed from the WebSphere Studio Application Developer launch pad.
It is not a component installed by the WebSphere Studio Application Developer,
Version 5.1.2 installation wizard.

For instructions, refer to IBM WebSphere Studio Application Developer for Windows
and Linux Installation Guide available on the WebSphere Studio Application
Developer CDs.

Apply the embedded messaging interim fixes to your WebSphere Application
Server test environment in WebSphere Studio Application Developer available at
the following URL:

|https://wwwl4.software.ibm.com/webapp/iwm/web/reg/pick.do?source=wsmqcsd|

Obtain and install the fixes found under WebSphere embedded messaging
interim fixes for WebSphere Application Server V5.1.1.

You will need an IBM ID and password to access the fixes. If you do not have
an IBM ID or password, click My IBM registration to obtain an ID and
password.

* You have the full test environment added to the WebSphere Commerce
development environment.

For instructions on adding the full test environment to the WebSphere
Commerce development environment, refer to |[“Adding the full WebSphere|
Commerce test environment to the WebSphere Commerce development|
environment” on page 29

You cannot use the WebSphere Studio Application Developer Embedded
Messaging Server with the lightweight test environment.

¢ The WebSphere Commerce development environment is running.

To start the WebSphere Commerce development environment, do one of the
following, depending on your edition of WebSphere Commerce Developer:

WYy Select Start > Programs > IBM WebSphere Commerce Developer Business
Edition > WebSphere Commerce development environment
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Select Start > Programs > IBM WebSphere Commerce Developer Professional
Edition > WebSphere Commerce development environment

Select Start > Programs > IBM WebSphere Commerce - Express Developer >
WebSphere Commerce development environment

Procedure:

To enable the Embedded Messaging Server in the WebSphere Commerce test
environments, do the following:

1. In the J2EE Hierarchy view in WebSphere Studio Application Developer,
expand Servers and double-click Full WebSphere Commerce Test
Environment.

2. On the Server page of the test environment view, expand JMS.
3. Add the following queues:
* JMSSeriallnboundQueue
* JMSParallelinboundQueue
* JMSErrorQueue
JMSOutboundQueue
* JMSInboundQueue
4. Do not change the values of Host and Port.
5. In the JMS Provider section, select Embedded Messaging.

6. Launch the administration console from within WebSphere Commerce
Developer by following the instructions in [“Starting the WebSphere|
Application Server Administrative Console in the WebSphere Commerce]
development environment” on page 65

7. Log in to the WebSphere Application Server Administrative Console.

8. In the navigation tree on the WebSphere Application Server Administrative
Console, expand Resources and click WebSphere JMS Provider.

9. Scope your changes to the Full WebSphere Commerce Test Environment by
selecting Server and clicking Apply.

10. Create a new connection factory by doing the following:

a. In the Additional Properties table on the WebSphere JMS Provider page,
click WebSphere Queue Connection Factories.

b. On the WebSphere Queue Connection Factories page, click New.
c. Complete the fields as follows:

Field Value

Name JMSQueueConnectionFactory

JNDI Name JMSQueueConnectionFactory

All other fields should be left at their default values.
d. Click OK.
11. Return to the WebSphere JMS Provider page.

12. Create a new queue destination for each queue you created earlier by doing
the following:

a. In the Additional Properties table on the WebSphere JMS Provider page,
click WebSphere Queue Destination.

b. On the WebSphere Queue Destinations page, click New.
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c. Complete the fields as follows:

Field Value

Name JMSSeriallnboundQueue

JNDI Name JMSSeriallnboundQueue

All other fields should be left at their default values.
d. Click OK.
e. Repeat steps through for the following queues:
JMSParallelinboundQueue
JMSErrorQueue
JMSOutboundQueue
* JMSInboundQueue

Enter the names of the queues in both the Name and JNDI Name fields.

13. Save your changes by doing the following:
a. In the taskbar, click Save.
b. On the Save page in the workspace, click Save.

14. Exit the WebSphere Application Server Administrative Console.

15. Save your changes to the Full WebSphere Commerce Test Environment by
selecting File > Save.

You must restart the Full WebSphere Commerce Test Environment for these
changes to take effect.
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Part 5. Uninstalling WebSphere Commerce Developer

If you encounter problems installing WebSphere Commerce Developer, you may
want to uninstall one or more components and start again. This section explains
how to uninstall each component of WebSphere Commerce Developer.
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Uninstalling the WebSphere Commerce toolkit

To uninstall the WebSphere Commerce toolkit, do the following;:
1. Select Start > Settings > Control Panel > Add/Remove Programs
2. Click Change or Remove Programs.

3. Select one of the following, depending on the edition you have installed:

wminey IBM WebSphere Commerce Business Edition toolkit 5.7
IBM WebSphere Commerce Professional Edition toolkit 5.7

IBM WebSphere Commerce - Express toolkit 5.7

4. Click Remove.
The uninstall wizard starts.
5. Complete the uninstall wizard by following the prompts.

The uninstall will only remove files that were originally installed. Files that were
created or modified after the installation will not be removed. You can delete the

WCDE _installdir directory once you have determined that you do not need any of

the remaining files.

— Uninstalling multiple toolkit installations
When you have multiple WebSphere Commerce toolkit installations on the
same machine, the entry in the Windows Add/Remove Programs panel only
uninstalls the most recent WebSphere Commerce toolkit installation.

To uninstall a specific WebSphere Commerce toolkit installation, you must
issue the following command:

WCDE_installdir/bin/uninstall

WCDE _installdir will be unique for each installation of the WebSphere
Commerce toolkit on a machine.
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Uninstalling WebSphere Studio Application Developer

Before uninstalling WebSphere Studio Application Developer, uninstall the
WebSphere Commerce toolkit by following the instructions in [“Uninstalling the|

[WebSphere Commerce toolkit” on page 55.

To uninstall WebSphere Studio Application Developer, complete the following
steps:

1.

While logged on with a Windows user ID with Administrator authority, select
Start > Settings > Control Panel > Add/Remove Programs.

Click Change or Remove Programs, select IBM WebSphere Studio
Application Developer 5.1.2 and click Change/Remove.

The uninstall wizard starts.

Complete the uninstall wizard by following the prompts.
When the uninstall is complete, restart your machine.
Delete the following directories:

* WSAD installdir

where the default value for WSAD_installdir is listed in [“Path variables” on|
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Part 6. Appendixes
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Appendix A. Troubleshooting your installation

Use the information in this section to troubleshoot your installation of WebSphere
Commerce developer

"Missing required library” messages in Tasks view
Symptom:

After starting the WebSphere Commerce development environment, you see one or
messages similar to the following in the WebSphere Studio Application Developer
Tasks view:

Missing required library: WSAD installdir/runtimes/base_v51/1ib/file

or
Missing required library: WSAD installdir/runtimes/base_v51_stub/1ib/file

Problem:

You do not have the required WebSphere Application Server 5.1 Test Environment
installed as part of WebSphere Studio Application Developer, Version 5.1.2.

Resolution:

To correct this problem, do the following:

1. Add the WebSphere Application Server 5.1 Test Environment to your
WebSphere Studio Application Developer, Version 5.1.2 installation, you must
run the WebSphere Studio Application Developer, Version 5.1.2 installation
wizard from the WebSphere Studio Application Developer, Version 5.1.2 CDs.
When completing the installation wizard, ensure that you select Integrated Test
Environments > WebSphere Application Server 5.1.

For instructions, refer to IBM WebSphere Studio Application Developer for Windows
and Linux Installation Guide available on the WebSphere Studio Application
Developer CDs.

2. Start the WebSphere Commerce development environment.

Wiy Select Start > Programs > IBM WebSphere Commerce Developer Business
Edition > WebSphere Commerce development environment

Select Start > Programs > IBM WebSphere Commerce Developer
Professional Edition > WebSphere Commerce development environment

Select Start > Programs > IBM WebSphere Commerce - Express Developer >
WebSphere Commerce development environment

3. Rebuild the Servers project as follows:
a. In the J2EE Hierarchy view, select Servers.
b. Select Project > Rebuild all.

4. Confirm that the Tasks view contains no error messages.
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The WebSphere Commerce development environment does not start

If the WebSphere Commerce development environment does not start, ensure that
you have WebSphere Studio Application Developer, Version 5.1.2 installed and that
the WSAD_HOME variable in the setenv.bat file is set to the full path to WebSphere
Studio Application Developer, Version 5.1.2.

To correct the value for WSAD_HOME, do the following:
1. Open the following the file in a text editor:
WCDE _installdir\bin\setenv.bat

2. Locate the line containing WSAD_HOME and ensure that it points to the full path
WebSphere Studio Application Developer, Version 5.1.2 (WSAD_installdir).

3. Save any changes and exit the text editor

Generic Errors received when accessing WebSphere Commerce
Payments
If you receive "Generic Error” messages when attempting to access any WebSphere

Commerce Payments function, apply the Microsoft Internet Explorer patch
available at the following URL:

|http://support.microsoft.com/?id=831167|
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Appendix B. WebSphere Commerce development environment
tasks

Starting WebSphere Commerce Developer

To start the WebSphere Commerce development environment, do one of the
following, depending on your edition of WebSphere Commerce Developer:

Select Start > Programs > IBM WebSphere Commerce Developer Business
Edition > WebSphere Commerce development environment

Select Start > Programs > IBM WebSphere Commerce Developer Professional
Edition > WebSphere Commerce development environment

Select Start > Programs > IBM WebSphere Commerce - Express Developer >
WebSphere Commerce development environment

Starting multiple instances of WebSphere Commerce
Developer

If you have the WebSphere Commerce toolkit installed multiple times, the entry in
the Windows Start menu starts the most recent installation of the WebSphere
Commerce toolkit.

To start other installations of the WebSphere Commerce toolkit, issue the following
command:

WCDE_installdir/bin/startWCToolkit

WCDE _installdir will be unique for each installation of the WebSphere Commerce
toolkit on a machine.

Starting and stopping WebSphere Commerce

Prerequisites:
* The WebSphere Commerce development environment is running.

For instructions on starting the WebSphere Commerce development
environment, refer to [“Starting WebSphere Commerce Developer.”]

 All test environments are stopped.
Procedure:

To start WebSphere Commerce within the WebSphere Commerce development
environment, do the following:

* In the Servers view, right-click one of the following, depending on the test
environment you want to start:

— Lightweight WebSphere Commerce Test Environment
— Full WebSphere Commerce Test Environment
* Select Start or Stop from the pop-up menu.

¢ Check the Console view to ensure that no errors occur as the WebSphere
Commerce application server starts.
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* The WebSphere Commerce is started successfully if there are no errors in the
Console view and the following message appears in the Console view:

Server serverl open for e-business

WebSphere Commerce Payments is also started with you start either test
environment.

Before accessing any of the WebSphere Commerce tools, ensure that you start the
WebSphere Commerce help system by following the instructions in [“Starting the

[WebSphere Commerce information center.”

Starting and stopping WebSphere Commerce Payments

Because WebSphere Commerce Payments is embedded into the test servers
available in the WebSphere Commerce development environment, WebSphere
Commerce Payments starts and stops when you start and stop the test
environments.

If you are using remote WebSphere Commerce Payments, start WebSphere
Commerce Payments following the instructions available in the WebSphere
Commerce Information Center.

Starting the WebSphere Commerce information center

The help system starts automatically in the development environment. By default
WebSphere Studio Application Developer runs the Help Server on a random port.

To start the help system in the WebSphere Commerce development environment,
do the following:

1. Ensure that the WebSphere Commerce tools in the development environment
can access the help system.

For instruction on enabling help access from the WebSphere Commerce tools in
the development environment, refer to [“Enabling help access from the]
[WebSphere Commerce tools in the development environment.”|

2. Start the WebSphere Commerce development environment.

For instructions on starting the WebSphere Commerce development
environment, refer to [“Starting WebSphere Commerce Developer” on page 63

3. Start the help system by selecting Help > Help Contents in the WebSphere
Commerce development environment.

Enabling help access from the WebSphere Commerce tools in
the development environment

To enable help to be accessed from the WebSphere Commerce Accelerator,
Organization Administration Console, or the Administration Console, you must set
the port that the help server uses to 8001, by doing the following:

1. Select Window > Preferences > Help > Help Server.
2. In the Port for the server to listen on field, type 8001.
3. Click Apply.

4. Restart WebSphere Studio Application Developer.
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Starting the WebSphere Application Server Administrative Console in
the WebSphere Commerce development environment

The WebSphere Application Server Administrative Console is not available if you
are using the lightweight test environment.

Prerequisites:

The WebSphere Commerce development environment is running.

For instructions on starting the WebSphere Commerce development
environment, refer to [“Starting WebSphere Commerce Developer” on page 63

The full test environment is available.

Procedure:

To start the WebSphere Application Server Administrative Console in the
WebSphere Commerce development environment, do the following;:

1.

3.
4.

Start the full test environment by doing the following:

a. In the Servers view, right-click Full WebSphere Commerce Test
Environment.

b. Select Start from the pop-up menu.
Wait for the full test environment to start.

The full test environment is started when you see the Server serverl open for
e-business in the Console view.

In the Servers view, right-click Full WebSphere Commerce Test Environment.

Select Run administrative console from the pop-up menu.

The WebSphere Application Server Administrative Console will appear in the
Admin Console view.

Accessing the Configuration page for a test environment

Prerequisites:

The WebSphere Commerce development environment is running.

For instructions on starting the WebSphere Commerce development
environment, refer to [“Starting WebSphere Commerce Developer” on page 63

All test environments are stopped.

Procedure:

To access the Configuration page for a test environment, do the following:

1.

2.

Stop any WebSphere Commerce test environments that may be running in
WebSphere Studio Application Developer.

In the J2EE Hierarchy view in WebSphere Studio Application Developer,
expand Servers and double-click one of the following:

* Full WebSphere Commerce Test Environment

This server is only available if you have added the full WebSphere
Commerce test environment to the WebSphere Commerce development
environment by following the instructions in [“Adding the full WebSphere]
Commerce test environment to the WebSphere Commerce development|
environment” on page 29|

* Lightweight WebSphere Commerce Test Environment
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The test environment view for the test environment you double-clicked
displays.
3. In the test environment view, select the Configuration page.

Note: Changes made in a test environment view apply to both test environments.
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Appendix C. Accessing WebSphere Commerce tools and
starter stores in WebSphere Commerce Developer

This section provides instructions on how to access the WebSphere Commerce tools
and starter stores from within the WebSphere Commerce development
environment.

WebSphere Commerce tools

Before you can access the WebSphere Commerce tools in the WebSphere Commerce
development environment, you must have one of the test environments started.

WebSphere Commerce Accelerator

To access the WebSphere Commerce Accelerator in a test environment, use the
following URL:

https://hostname:8000/webapp/wcs/tools/serviet/
ToolsLogon?XMLFile=common.mcLogon

where hostname is the fully qualified host name of the WebSphere Commerce
Developer machine. If you are accessing WebSphere Commerce Accelerator directly
from the WebSphere Commerce Developer machine, you can use Tocalhost as the
host name.

The initial ID is wcsadmin. The initial password is wcsadmin.

For more information on the WebSphere Commerce Accelerator, refer to the
WebSphere Commerce Information Center.

WebSphere Commerce Administration Console

To access the WebSphere Commerce Administration Console in a test environment,
use the following URL:

https://hostname :8002/webapp/wcs/admin/serviet/
ToolsLogon?XMLFile=adminconsole.AdminConsolelLogon

where hostname is the fully qualified host name of the WebSphere Commerce
Developer machine. If you are accessing WebSphere Commerce Administration
Console directly from the WebSphere Commerce Developer machine, you can use
Tocalhost as the host name.

The initial ID is wcsadmin. The initial password is wcsadmin.

For more information on the WebSphere Commerce Administration Console, refer
to the WebSphere Commerce Information Center.

WebSphere Commerce Organization Administration Console

To access the WebSphere Commerce Organization Administration Console in a test
environment, use the following URL:

https://hostname:8004/webapp/wcs/orgadmin/serviet/
ToolsLogon?XMLFile=buyerconsole.BuyAdminConsolelLogon
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where hostname is the fully qualified host name of the WebSphere Commerce
Developer machine. If you are accessing WebSphere Commerce Organization
Administration Console directly from the WebSphere Commerce Developer
machine, you can use localhost as the host name.

The initial ID is wcsadmin. The initial password is wcsadmin.

For more information on the WebSphere Commerce Organization Administration
Console, refer to the WebSphere Commerce Information Center.

WebSphere Commerce Payments console

To access the WebSphere Commerce Payments console for WebSphere Commerce
Payments running in a test environment, use the following URL:

https://hostname/webapp/PaymentManager/PaymentServerUI/Start

where hostname is the fully qualified host name of the WebSphere Commerce
Developer machine. If you are accessing WebSphere Commerce Organization
Administration Console directly from the WebSphere Commerce Developer
machine, you can use localhost as the host name.

The initial ID is wcsadmin. The initial password is wcsadmin.

For more information on the WebSphere Commerce Payments console, refer to the
WebSphere Commerce Information Center.

WebSphere Commerce development environment database
access tool

If you need to issue SQL statements against the WebSphere Commerce database
while a test environment is running, use the following URL:

http://hostname/webapp/wcs/admin/serviet/db.jsp

where hostname is the fully qualified host name of the WebSphere Commerce
Developer machine. If you are accessing this URL directly from the WebSphere
Commerce Developer machine, you can use Tocalhost as the host name.

This will provide an entry field where you can issue SQL statements that will
execute against the WebSphere Commerce database.

To issue SQL commands against the WebSphere Commerce database
when the lightweight WebSphere Commerce test environment is stopped, use the
ij.bat utility to start a Cloudscape SQL session as follows:

1. Shut down your test environment.
2. Navigate to the WCDE_installdir\bin directory.
3. Issue the following command:

ij.bat

This starts a Cloudscape SQL session.
4. Issue the following command to connect to the WebSphere Commerce database:

connect '..\db\mall';

When working in a Cloudscape SQL session, ensure that you end all of your SQL
statements with a semicolon.
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To close a Cloudscape SQL session, issue the following command:
exit;

WebSphere Commerce starter stores

Before you can access the starter stores, you must have one of the test
environments started and the starter store you want to access must be published in
the test environment.

After the initial installation of WebSphere Commerce Developer, all of the starter
stores provided with your edition of WebSphere Commerce Developer are
published in the lightweight WebSphere Commerce test environment. For the full
WebSphere Commerce test environment, you must publish each starter store
manually.

In the following sections, refer to the Edition notice to see if the starter store
discussed is provided with your edition of WebSphere Commerce Developer.

Advanced B2B Direct starter store

— Edition notice
The Advanced B2B Direct starter store is provided with WebSphere
Commerce Developer Business Edition.

The Advanced B2B Direct starter store is not provided with WebSphere
Commerce Developer Professional Edition or WebSphere Commerce - Express
Developer Edition

To access the Advanced B2B Direct starter store in a test environment, use the
following URL:

http://hostname/webapp/wcs/stores/serviet/AdvancedB2BDirect/index.jsp

where hostname is the fully qualified host name of the WebSphere Commerce
Developer machine. If you are accessing the Advanced B2B Direct starter store
directly from the WebSphere Commerce Developer machine, you can use
Tocalhost as the host name.

For more information on the Advanced B2B Direct starter store, refer to the
WebSphere Commerce Information Center.

B2B Direct starter store

— Edition notice
The B2B Direct starter store is provided with WebSphere Commerce
Developer Professional Edition and WebSphere Commerce - Express
Developer Edition

The B2B Direct starter store is not provided with WebSphere Commerce
Developer Business Edition.

To access the B2B Direct starter store in a test environment, use the following URL:
http://hostname/webapp/wcs/stores/serviet/B2BDirect/index.jsp

Appendix C. Accessing WebSphere Commerce tools and starter stores in WebSphere Commerce Developer 69



where hostname is the fully qualified host name of the WebSphere Commerce
Developer machine. If you are accessing the B2B Direct starter store directly from
the WebSphere Commerce Developer machine, you can use Tocalhost as the host
name.

For more information on the B2B Direct starter store, refer to the WebSphere
Commerce Information Center.

Consumer Direct starter store

Edition notice
The Consumer Direct starter store is provided with WebSphere Commerce
Developer Business Edition, WebSphere Commerce Developer Professional
Edition, WebSphere Commerce - Express Developer Edition

To access the Consumer Direct starter store in a test environment, use the
following URL:

http://hostname/webapp/wcs/stores/serviet/ConsumerDirect/index.jsp

where hostname is the fully qualified host name of the WebSphere Commerce
Developer machine. If you are accessing the Consumer Direct starter store directly
from the WebSphere Commerce Developer machine, you can use localhost as the
host name.

For more information on the Consumer Direct starter store, refer to the WebSphere
Commerce Information Center.

Commerce Hosting Hub starter store

— Edition notice
The Commerce Hosting Hub starter store is provided with WebSphere
Commerce Developer Business Edition.

The Commerce Hosting Hub starter store is not provided with WebSphere
Commerce Developer Professional Edition or WebSphere Commerce - Express
Developer Edition

To access the Commerce Hosting Hub starter store in a test environment, use the
following URL:

http://hostname/webapp/wcs/stores/serviet/CommerceHostingHub/index.jsp

where hostname is the fully qualified host name of the WebSphere Commerce
Developer machine. If you are accessing the Commerce Hosting Hub starter store
directly from the WebSphere Commerce Developer machine, you can use
Tocalhost as the host name.

For more information on the Commerce Hosting Hub starter store, refer to the
WebSphere Commerce Information Center.
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Commerce Plaza starter store

— Edition notice
The Commerce Plaza starter store is provided with WebSphere Commerce
Developer Business Edition.

The Commerce Plaza starter store is not provided with WebSphere Commerce
Developer Professional Edition or WebSphere Commerce - Express Developer
Edition

To access the Commerce Plaza starter store in a test environment, use the following
URL:

http://hostname/webapp/wcs/stores/serviet/CommercePlaza/index.jsp

where hostname is the fully qualified host name of the WebSphere Commerce
Developer machine. If you are accessing the Commerce Plaza starter store directly
from the WebSphere Commerce Developer machine, you can use Tocalhost as the
host name.

For more information on the Commerce Plaza starter store, refer to the WebSphere
Commerce Information Center.

Commerce Supplier Hub starter store

— Edition notice
The Commerce Supplier Hub starter store is provided with WebSphere
Commerce Developer Business Edition.

The Commerce Supplier Hub starter store is not provided with WebSphere
Commerce Developer Professional Edition or WebSphere Commerce - Express
Developer Edition

To access the Commerce Supplier Hub starter store in a test environment, use the
following URL:

http://hostname/webapp/wcs/stores/serviet/SupplierMarketplace/index.jsp

where hostname is the fully qualified host name of the WebSphere Commerce
Developer machine. If you are accessing the Commerce Supplier Hub starter store
directly from the WebSphere Commerce Developer machine, you can use
Tocalhost as the host name.

For more information on the Commerce Supplier Hub starter store, refer to the
WebSphere Commerce Information Center.
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Appendix D. Where to find more information

More information about the WebSphere Commerce Developer system and its
components is available from a variety of sources in different formats. The
following sections indicate what information is available and how to access it.

WebSphere Commerce Developer information

The following are the sources of WebSphere Commerce Developer information:

* [“WebSphere Commerce Developer information center”|

[“WebSphere Commerce Developer support Web site”|

[“WebSphere Commerce library” on page 74|

[“WebSphere Developer Domain” on page 74|
[‘IBM Redbooks” on page 74|

WebSphere Commerce Developer information center

The WebSphere Commerce Developer information center is your primary source of
information for creating and publishing stores in WebSphere Commerce Developer.

To view the WebSphere Commerce Developer information center, do the following:
1. Start the WebSphere Commerce development environment.
2. From the Help menu, select Help Contents.

3. After a few moments, the information center displays. In the navigation pane
of the information center, click WebSphere Commerce.

Note: If you refer to instructions for multiple platforms in the WebSphere
Commerce Information Center, ensure you follow the instructions for
WebSphere Commerce Developer. When a help page contains information
for multiple platforms, information specific to WebSphere Commerce
Developer is indicated with the following icon:

Developer

If information specific to WebSphere Commerce Developer is not available,
ensure you follow instructions specific to Windows, When a help page
contains instructions for multiple platforms, instructions for Windows are
indicated with the following icon:

WebSphere Commerce Developer support Web site

The WebSphere Commerce Developer support Web site is your source for fixes and
technotes related to WebSphere Commerce Developer. The WebSphere Commerce
Developer support Web site is available at the following URL:

|http://www.ibm.com/software/genservers/commerce/commercestudio/support/|

© Copyright IBM Corp. 1996, 2005 73


http://www.ibm.com/software/genservers/commerce/commercestudio/support/

WebSphere Commerce library

WebSphere Commerce Developer product information is available at the
WebSphere Commerce library. Refer to the following URL for more product
information:

|http://www.ibm.com/software/webservers/commerce/library/|

WebSphere Developer Domain

Additional information on WebSphere Commerce Developer and WebSphere
Commerce is also available in the WebSphere Commerce Zone at WebSphere
Developer Domain:

|http://www.ibm.com/websphere/developer/zones/commerce/|

IBM Redbooks

WebSphere Commerce Developer and WebSphere Commerce information is
available at the IBM Redbooks " Web site:

|http://www.ibm.com/redbooks|

WebSphere Studio Application Developer information

The following are sources of information for WebSphere Studio Application
Developer:

* [“WebSphere Studio Application Developer online help”]

* |“WebSphere Studio Application Developer Web site”|

* [“WebSphere Developer Domain”|
* |“IBM Redbooks” on page 75|

WebSphere Studio Application Developer online help

The WebSphere Studio Application Developer online help is your primary source
of information on how to perform tasks within WebSphere Studio Application
Developer.

To view the WebSphere Studio Application Developer online help, do the
following:

1. Start WebSphere Commerce Developer by selecting Start > Programs > IBM
WebSphere Studio > Application Developer > V5.1.1.

2. From the Help menu, select Help Contents.

WebSphere Studio Application Developer Web site

WebSphere Studio Application Developer product information is available on the
WebSphere Studio Application Developer Web site:

[http://www.ibm.com/software/ad/studioappdev/1ibrary/|

WebSphere Developer Domain

Additional information on WebSphere Studio Application Developer is available on
the WebSphere Studio Application Developer page of the WebSphere Studio Zone
of WebSphere Developer Domain:

|http://www.ibm.com/websphere/developer/zones/studio/appdev/|
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IBM Redbooks

WebSphere Studio Application Developer information is available at the IBM
Redbooks Web site:

|http://www.ibm.com/redbooks|

Appendix D. Where to find more information 75


http://www.ibm.com/redbooks/

76 WebSphere Commerce Developer Installation Guide



Notices

This information was developed for products and services offered in the U.S.A.

IBM may not offer the products, services, or features discussed in this document in
other countries. Consult your local IBM representative for information on the
products and services currently available in your area. Any reference to an IBM
product, program, or service is not intended to state or imply that only that IBM
product, program, or service may be used. Any functionally equivalent product,
program, or service that does not infringe any IBM intellectual property right may
be used instead. However, it is the user’s responsibility to evaluate and verify the
operation of any non-IBM product, program, or service.

IBM may have patents or pending patent applications covering subject matter
described in this document. The furnishing of this document does not give you
any license to these patents. You can send license inquiries, in writing, to:

IBM Director of Licensing
IBM Corporation

North Castle Drive
Armonk, NY 10504-1785
U.S.A.

For license inquiries regarding double-byte (DBCS) information, contact the IBM
Intellectual Property Department in your country or send inquiries, in writing, to:

IBM World Trade Asia Corporation
Licensing

2-31 Roppongi 3-chome, Minato-ku
Tokyo 106, Japan

The following paragraph does not apply to the United Kingdom or any other
country where such provisions are inconsistent with local law:

INTERNATIONAL BUSINESS MACHINES CORPORATION PROVIDES THIS
PUBLICATION "AS IS” WITHOUT WARRANTY OF ANY KIND, EITHER
EXPRESS OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED
WARRANTIES OF NON-INFRINGEMENT, MERCHANTABILITY OR FITNESS
FOR A PARTICULAR PURPOSE.

Some states do not allow disclaimer of express or implied warranties in certain
transactions, therefore, this statement may not apply to you.

This information could include technical inaccuracies or typographical errors.
Changes are periodically made to the information herein; these changes will be
incorporated in new editions of the publication. IBM may make improvements
and/or changes in the product(s) and/or the program(s) described in this
publication at any time without notice.

Any references in this information to non-IBM Web sites are provided for
convenience only and do not in any manner serve as an endorsement of those Web
sites. The materials at those Web sites are not part of the materials for this IBM
product and use of those Web sites is at your own risk.
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IBM may use or distribute any of the information you supply in any way it
believes appropriate without incurring any obligation to you.

Licensees of this program who wish to have information about it for the purpose
of enabling: (i) the exchange of information between independently created
programs and other programs (including this one) and (ii) the mutual use of the
information which has been exchanged, should contact:

IBM Canada Ltd.

Office of the Lab Director
8200 Warden Avenue
Markham, Ontario

L6G 1C7

Canada

Such information may be available, subject to appropriate terms and conditions,
including in some cases, payment of a fee.

The licensed program described in this document and all licensed material
available for it are provided by IBM under terms of the IBM Customer Agreement,
IBM International Program License Agreement or any equivalent agreement
between us.

Trademarks

The IBM logo and the following terms are trademarks or registered trademarks of
International Business Machines Corporation in the United States or other
countries or both:

* Cloudscape

 DB2

* DB2 Universal Database
* IBM

* MQSeries

* Redbooks

* Tivoli

* WebSphere

Intel and Pentium is a registered trademark of Intel Corporation in the United
States, other countries, or both.

Java and all Java-based trademarks and logos are trademarks or registered
trademarks of Sun Microsystems, Inc. in the United States, other countries, or both.

Linux is a trademark of Linus Torvalds in the United States, other countries, or
both.

Microsoft and Windows are trademarks or registered trademarks of Microsoft
Corporation in the United States, other countries, or both.

Other company, product and service names may be trademarks or service marks of
others.
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